The Wildlife Trusts’ identity TRUSTS

Protecting Wildlife for the Future



Introduction

Achievement of a cohesive brand is in the top five of The
Wildlife Trusts’ priorities. This was agreed by all Trusts in
the development strategy in June 2007.

‘Brand’ may be defined as ‘the bundle of values, feelings
and impressions that key stakeholders have of an
organisation’. Every impression formed in the mind of a
member, a funder or a politician is also part of the brand.
Every message sent out by one of our CEOs is also part

of the brand, as is every communication from one of our
trustees, our volunteer reserve wardens, our receptionists,
our press officers. In short, while communications staff are
pivotal in brand development, each and every one of us in
every part of the movement has a vital role to play in our
unique brand of The Wildlife Trusts.

Why is this important? In brief, brand confusion creates
risks. These can include losses: in funding opportunities,
in membership and also in respect. Brand coherence,
meanwhile, boosts profile and positioning locally,
nationally and across the UK. It opens doors to fundraising
and influence. The more consistent we are, the more legal
protection we have.

The following guidelines have been developed to clarify
use of the visual elements of our brand as agreed by the
movement at Joint Forum in June 2008.

The Wildlife Trusts 2009
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VI S I O n The Wildlife Trusts 2009

The vision of The Wildlife Trusts is:
“an environment rich in wildlife for everyone”

The mission of The Wildlife Trusts is to:
“rebuild biodiversity and engage people with their environment”

The Wildlife Trusts’ aim is:
(for internal use only)

“to be the UK’s most active and influential wildlife champion”

We see our unique role as:
“People taking action for local wildlife everywhere in the UK”

Values
The Wildlife Trusts’ brand should be associated with the words:

Influential, Authoritative, Active, Inspiring and Engaging

July 2008
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For any queries regarding
these guidelines, please contact:

The Wildlife Trusts

The Kiln

Waterside

Mather Road

Newark

Nottinghamshire

NG24 1WT

Tel: 01636 677711

Fax: 01636 670001
acormack@wildlifetrusts.org

Charity Registration
Number: 207238

www.wildlifetrusts.org

Many thanks to the following for the
photography in this booklet:
Neil Aldridge

Les Binns

Steve Day

Mark Harvey

Pete Horne

Arthur Kingdon

Mike Markey

Stewart McDonald

npower

Ben Osborne

Philip Precey

Rachel Scopes

Darin Smith

JP Trenque

Martha Tressler

Damian Waters

David Woodfall BBCWT
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T h e LO g O The Wildlife Trusts 2009

Minimum clearance The individual Trusts identities

A minimum area within and
surrounding the logo should

be kept clear of any other printed publications.

typography or graphic elements. The Wildlife Trust It should always appear in
name is all that is black and white. Under no

- The logo can sit over background wl'l dlif-e
THE o 0 photos, so long as clearance rules required under the logo. .
are followed. Minimum clear space TRUSTS c1rcumsta.nces should the
wz l e . . logo be distorted, altered,
on all sides is equal to the width .
TR U STS re-created, colour-adjusted

and height of the capital letter “T”, : : .
taken from the word “TRUSTS’ or simplified from what is
shown.

that appears in the logo.
e Where the individual Trust
w Incorrect name is required to appear

& W The Wildlife Trusts’ logo
w V Correct should be used on all

in conjunction with the

Avoid repeating logo, the Trust name
‘Wildlife Trust” under

THE : .
. o y 4 should be set in Univers
A minimum size is recommended to wz l e the logo.

ensure legibility in print applications. TRUSTS bold and centred under

Minimum printed width = 12mm. the logo.

Minimum size

We ss ex Examples of individual

Wildlife Trust Trust logos are shown

below.

Please refer to the grids for

Bedfordshire logo and name placement

Cambridgeshire on publication covers.
Northamptonshire

Royal Society of
Wildlife Trusts

Peterborough

Northumberland Leicestershire Lancashire
& Rutland Manchester &
N Merseyside
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Typography

Lower case letter ‘a’ in
Univers 55 regular

Lower case letter ‘b’ in
Sabon regular

Primary fonts

Univers 45 light

Univers 45 light oblique

Univers 55 roman (regular)
Univers 55 oblique

Univers 65 bold

Univers 65 bold oblique

Univers 85 extra black
Univers 85 extra black oblique

Sabon

Sabon italic
Sabon bold
Sabon bold italic

Secondary fonts

Arial regular
Avrial italic

Arial bold

Arial bold italic

Times New Roman regular
Times New Roman italic
Times New Roman bold
Times New Roman bold italic

The Wildlife Trusts 2009

The Wildlife Trusts’ corporate
typefaces are Univers and
Sabon. These have been
chosen for their clarity and
ease of use. As a general rule,
use Univers light / roman /
bold for headlines, titles and
covers (see grids). Sabon
regular or Univers regular
may be used for body copy.

Consistent use of typography
aids public recognition of all
Wildlife Trusts and of the
collective identity. Please
avoid allowing individual
designers the opportunity to
‘freshen-up’ or ‘modernise’
the look.

If Univers and Sabon are
not available, these may be
substituted for Arial and
Times New Roman.
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Colour palette

#BAAFD3

Pantone 270
30c 23m Oy Ok

#AADDDG6

Pantone 324
27c¢ Om 11y Ok

#38197A

Pantone 273
100c 94m Oy 6k

#008789

Pantone 321
100c Om 30y 23k

#B5CC8E

Pantone 577
23c Om 50y 11k

#D88COC

Pantone 138
Oc 38m 94y 0k

#007A3D

Pantone 356
100c Om 91y 27k

#E23D28

Pantone 179
Oc 79m 94y 0k

The Wildlife Trusts 2009

Our colours were selected to
evoke tones of nature — both
land and marine. This is an
updated colour palette — an
‘evolved’ version of the one
produced in 2000.

When these colours are
printed as process separation
(CMYK) on promotional
materials such as brochures,
printers should be asked to
match the process version of
the relevant colour as closely
as possible to the Pantone
from which it was created.
Designers can supply Pantone
swatches to printers.

The closest screen colours are
also indicated.
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The strapline

Protecting Wildlife for the Future

Protecting Wildlife for the Future

Protecting Wildlife for the Future

Protecting Wildlife for the Future

Protecting Wildlife for the Future

Protecting Wildlife for the Future

Protecting Wildlife for the Future

Protecting Wildlife for the Future

Protecting Wildlife for the Future

The Wildlife Trusts 2009

The strapline appears in

the bottom right corner
with white text reversed out
of a black strip. Wildlife is
in bold.

Alternatively, one of the
other colours may be used

as shown here.

Please refer to the grids for
type sizes and positioning.

Back to contents 7



Univers
for titling

Campaign slogans

210

15 145 10 30 10

Saving our Al E
precious sealife

60

Wiltshire

Univers .
roman for & IrE

Ml  Créating A Living Landscape

A
¢

Securing Living Seas

Protecting Wildlife for the Future E Protecting Wildlife for the Future

\ 14 pt Univers

roman / bold

\ 14 pt Univers

roman / bold

The Wildlife Trusts 2009

Protecting Wildlife for
the Future is our current
strapline, however, we
are aware of the need to
associate ourselves with
Living Landscapes and
Living Seas. Therefore we
advise using the slogans
as much as possible.

The campaign slogans are:
Securing Living Seas

Creating A Living Landscape

Back to contents 8



Univers
for titling

Master grids: A4 portrait

Grid 1 (recommended)

The Wildlife Trusts
Annual Review 2007/8

All measurements in mm

60

Univers
for titling

\ 14 pt Univers

roman / bold

210

155 30

A Living Landscape

restore, recreate, reconnect

Protecting Wildlife for the Future

The Wildlife Trusts 2009

This is the recommended
grid for A4 portrait
publication covers.

If the photograph
allows, the title bar may
be removed.

This example (right) also
demonstrates how the top
band of colour (shown in
the grids) can be removed,
as long as the title space
remains clear of fussy
imagery and the type is
clearly legible.

Download InDesign CS3 template
(A4 portrait horizontal band)

Download InDesign CS3 template
(A4 portrait no band)

Back to contents 9



17pt Univers
bold for
Trust name

Univers
for titling

Master grids: A4 portrait

Vertical Bar Grid

210

15 145 10 30

Hampshire & Isle of Wight
Wildlife Trust

\Wetlands for
wildlife :

—

==
- b ] | = .
—— - T
<l
Protecting Wildlife for the Future

\ 14 pt Univers

roman / bold

All measurements in mm

210

15 145

n © Volunteering:
unlocking the potential

Univers
for titling

Warwickshire

Protecting Wildlife for the Future

\ 14 pt Univers

roman / bold

The Wildlife Trusts 2009

This is a grid for A4
portrait publication covers
where the coloured bar is
used vertically.

When using this grid,
ensure the publication title
can be read easily when
placed on the photograph.

The black strapline bar
should be used with this
grid.

Download InDesign CS3 template
(A4 portrait vertical band 1)

Download InDesign CS3 template
(A4 portrait vertical band 2)

Back to contents 10



Master grids: A4 landscape

Grid 1 (recommended)

297

Derbyshire
Wildlife Trust

Univers
bold

All measurements in mm

242 30 10

60

-+ Annual Review
2006/2007

Protecting Wildlife for the Future

\ 14 pt Univers

roman / bold

The Wildlife Trusts 2009

This is the recommended
grid for A4 landscape
publication covers.

Download InDesign CS3 template
(A4 landscape horizontal band)

Back to contents 11



Master grids: Ab portrait The Wildife Trusts 2009

Grid 1 (recommended) Grid 2 (recommended)

148

These are recommended

Berkshire, Buckinghamshire

Ovfordshire grids for AS publication
42 T . ‘ 42 covers.
Wildlife Gardening
Univers Download InDesign CS3 template
roman / bold (AS portrait grid 1)
Univers

roman /bold Download InDesign CS3 template

(AS portrait grid 2)

Protecting Wildlife for the Future

\11 pt Univers \ 11 pt Univers

roman / bold roman / bold

All measurements in mm Back to contents 12



Master grids: A5 portrait

Grid 3
148
] PN
N~——
nowox | ‘Fake a closer
s | look at wildlife

Protecting Wildlife for the Future

\ 11 pt Univers

roman / bold

All measurements in mm

oo}

Univers
Extra Black

The Wildlife Trusts 2009

This is an alternative grid
for AS publication covers
which allows for inclusion
of an individual Trust’s
logo.

Download InDesign CS3 template
(AS portrait grid 3)

Back to contents 13



Master grids: DL

Grid 1 (recommended)

Nottinghamshire 42
Wildlife Trust

Univers
bold

Univers

bold
Help protect

your focal

wildlife

Protecting Wildlife for the Future

\ 10 pt Univers

roman / bold

All measurements in mm

Grid 2 (recommended)

Bedfordshire Cambridgeshire
Northamptonshire Peterborough

Walton Woods v

nature reserve

A place for wildlife

Protecting Wildlife for the Future

\ 10 pt Univers

roman / bold

The Wildlife Trusts 2009

These are recommended
grids for DL publication
covers.

Download InDesign CS3 template
(DL portrait grid 1)

Download InDesign CS3 template
(DL portrait grid 2)

Back to contents 14



Newsletters

L4

Wi IdTi mes Wildlife

Borcestershire Wildlife Trust MRCISTES

Join the Great North
Squirrel Quest

f rd day’s work at
Tarn Sike

Elephants, sharks and
Iwhales on Frontmere

Protecting Wildlife for the Future

All measurements in mm

210

60

Borcestershire Wildlife Trust Conservation Volunteers

This is an example of bodycopy. The
purpose of bodycopy is to simulate text
typesetting in order to give an idea of
what a finished piece of design will look
like. Depending upon the level to which
you require to take your design visual,
you may choose differing techniques to
represent text. The quickest, easiest
method is simply to use horizontal lines
drawn with a grey or black marker,
corresponding approximately to the x-
height of the typeface to be used.
Alternatively two parallel lines may be
drawn which exactly match the x-height
of the typeface. The weight and density
of the type is then shown by filling
between the lines with a 'squiggle’ to
give the impression of words, sentences
and paragraphs. By varying the start or
endlength of these lines it also possible
to suggest ranged left, right or justified

E Protecting Wildlife fi uture

//

10 years of the Red Kite

typographic layouts. One of the most
professional techniques for text simulation
is the is the use of bodytype transfer
sheets. These are self adhesive sheets of
transparent film which carry actual typeface
examples. They allow for the position and
reposition of whole blocks of type with
maximum ease. The type comes in a
variety of sizes, weights and leadings in
white or black or a limited range of colours.
Itis therefore possible to create the effect
of reversed out type from a coloured
background or colour on colour text etc.
Finally you can use the electronic page
make-up systems to generate body copy.
By entering this copy onto a MacWiite file
with no parameters set, you can save it
as raw copy. After establishing column
widths, typeface, typestyle etc. ina
Pagemaker file, you can then pour the text
through to simulate text in page layouts

60

The Wildlife Trusts 2009

Alternative layouts for
newsletters and magazines.

Download InDesign CS3 template
(A4 newsletter full colour)

Download InDesign CS3 template
(A4 newsletter two colour)

Back to contents
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Partners and sponsors

148

Agriculture and o~
wildlife conservation ThUSTS

Essex

Protecting Wildlife for the Future

All measurements in mm

Derbyshire wildlife 42
Wildlife Trust

AGuide to
. Derbyshire’s
Upland
Woodland

Protecting Wildlife for the Future

The Wildlife Trusts 2009

Ideally, where The Wildlife
Trusts are the main author
of a document, sponsors/
partners should be referred
to in writing on the covers
of jointly published
documents rather than
through their corporate
identity. For example:

‘The Wildlife Trusts in
association with Vine
House Farm’. Sponsor
logo(s) can then ‘sign-off’
the document or publication
on the back cover. This
reduces confusion among
our target audiences.

The most important aspect
is to agree expectations with
partners/sponsors at the
outset of each project.

Download InDesign CS3 template
(AS portrait cover)

Download InDesign CS3 template
(DL portrait cover)

Back to contents 16



Stationery

85

11pt Univers roman |

o [~ Paul M
7pt Sabon italic aul Murby

[ Spokesperson for Borsetshire

- Borsetshire
/ 1 The High Street
Borset

Borsetshire BS1 18T

12pt Univers roman
6.5pt Sabon italic —— |

¢
wwcildifetrusts.org

210

150 23 10

: Borsetshire

14pt Univers roman ko r
oo 1TheHighStrex
8pt Sabon italic Borset

Borsetshire BS1 1BT

Tel: 01636 677711

Fax: 01636 670001
enquiry@uildlifetrusts.org
wiow.wildlifetrusts.org

With Compliments
15 Protecting Wildlife for the Future

Bedfordshire, Cambridgeshire,
Northamptonshire and Peterborough

11pt Univers roman

1 The High Street

Borset

Borsetshire BS1 1BT

Tel: 01636 677711

Fax: 01636 670001
enquiry@uildlifetrusts.org
www.wildlifetrusts.org

With Compliments
Protecting Wildlife for the Future

25

[l

55

210

1560 23

/ Borsetshire
1 The High Street

Borset

Borsetshire BS1 1BT

Tel: 01636 677711

Fax: 01636 670001
enquiry@uildiifetrusts.org

/ www.wildlifetrusts.org
9pt Sabon italic

6pt Sabon italic

14pt Univers roman

12pt Univers roman
‘Wildlife’ in Univers bold

Protecting Wildlife for the Future

All measurements in mm

The Wildlife Trusts 2009

Please follow these grids
when producing stationery
if printing in black only.

Download Microsoft Word template
(A4 Letterhead)

Download InDesign CS3 template
(A4 Letterhead)

Download InDesign CS3 template
(Compliments slips)

Download InDesign CS3 template
(Business card)

Back to contents 17



Stationery

Posters/notices/news

210

Wildlife Trust Ecology Groups

The 1 for all E

in Bedf ire,

g Spring 2009

Welcome to the latest issue of the

ter for our d ping teams of
Ecology Group members.

This newsletter is free to all members

of the Wildlife Trust Ecology Groups
(WTEGS). As a source of feedback, it is a
review of their achievements and how the
Ecology Groups are helping to improve
how we manage our nature reserves.

Named after their extremely long antennae,
longhorn beetles are a useful group of insects
when it comes to conservation. The adults, such as

The first Ecology Groups Conference, 2009:
Reviewing the progress and successes, and
revealing new ideas, read about the presentations
made at the first ever Ecology Groups Conference
on pages 9-13.

Bat Pathfinders

Information on how to get involved in a
new explorer project in Cambridgeshire and
Northamptonshire can be found on page 2.

Botanical teamwork

This year we will be setting up two teams to

carry forward our plans for botanical monitoring
on our grassland nature reserves. Supported by
the Franklyn Perring Fund, we will be recruiting
Ecology Group team leaders to help organise
volunteers to complete annual monitoring projects
in northern and southern Northamptonshire. See
pages 2 & 14.

Take to the wing
Can you identify birds by their calls? If so

we are looking to expand our monitoring
programme in Bedfordshire, Cambridgeshire and
Northamptonshire, to increase the number of
reserves we are monitoring using breeding bird
data. Can you help? See page 2.

Pond life

Many of the pits, ponds, pools, scrapes and
ditches along the Nene Valley are valuable for their
invertebrates. The Nene Valley Ecology Group will
be meeting at Lings House on Wednesday 9 May,
to organise fieldwork and training on

water beetle identification, see page 3.

Dukes and Blues
Get involved in a very special butterfly project in
Bedfordshire this year, see page 3.

Longhorn Lookout 2009
Following the success of last years explorer project

Leptura maculata, feed on the nectar of
plants along woodland rides, while the young live
in deadwood. Monitoring them may help us to test
how well we are managing our woodlands.

All measurements in mm

(see the 1 report on page
11), this year's work is already underway and will
continue into the summer, see

page 3 for details.

Protecting Wildlife for the Future

~

~

39

i

210

171

Scarecrow

Northumberland

Trail

at Sutton Courtenay Environmental

Education Centre
14th to 17th April 2009

We are situated:
Elsdon end of Milton Park.

All welcome!

Parking is limited, so we would
appreciate full cars/bikes or
using the bus if possible!
Everyone welcome to

bring along a picnic

No Dogs

Tea and Coffee will be available

@

For more information please contact:

(AN

st;}xﬁ
~7 .
Reserve open from 10am til 3.30pm :
P P! o

TS

Y
<
%

Northumberland Wildlife Trust, St Nicholas Park, Gosforth

Newcastle upon Tyne, Tyne and Wear NE3 3XT

Tel: (0191) 284 6884 Email: mail@northwt.org.uk Visit:

www.nwt.org.uk

Protecting Wildlife for the Future

The Wildlife Trusts 2009

Stock paper for use when
printing posters, notices
and simple newsletters

in house.

Can be used with grids on
page 25.

Download Microsoft Word template
(Grid 1)

Download Indesign CS3 template
(Grid 1)

Download Microsoft Word template
(Grid 2)

Download Indesign CS3 template
(Grid 2)

Back to contents 18



Exhibitions and signage

Bedfordshire
Cambridgeshire

Northamptonshire
Peterborough

Welcome

>

Creating "“Q“
Living Landscapes

~‘*--..;_(_vw\@ﬂ/\mﬂglife bcn;?qrg

Protecting Wildlife for the Future

Exhibition banner

The Wildlife Trusts 2009

When designing an exhibition
stand, consistency with type
and colour and focus on
minimal words are key. A
good example is shown here.

Signs and interpretation
panels on reserves have
been covered in an earlier
guidelines publication and
are not dealt with in this
guide. We will review these
at a later stage.

Back to contents 19



Vehicles

-
wildlife \
TRUSTS
www.borsetshirewt.org.uk Borsetshire
Sponsored by Protecting Wildlife for the Future

™~

Protecting Wildlife for the Future

U 4
TRUSTS|

Borsetshire

Logo appears on the
side doors of the car

|

é/O\V@/ /

Logo appears on the side panels of the van. Wherever possible
separate sponsor and The Wildlife Trusts’ logo/messages

The Wildlife Trusts 2009

We use a variety of
vehicles. The important
rules are: focus on logo
and Trust name and then
strapline and then web
address, in that order.

Wherever possible use
doors (on cars) or main
side panels (on vans) for
locating the identity. The
strapline should appear
in black on light coloured

vehicles and white on

)

dark coloured vehicles.

www.borsetshirewt.org.uk

Protecting Wildlife
for the Future

[ TRUSTS)
Borsetshire

Logo appears on the
back doors of the van

Back to contents 20



M e rC h a n d i S e The Wildlife Trusts 2009

The logo can make a clear
statement on clothing and
other merchandise.

On Trust merchandise,
the individual Trust’s
name should be centred
under The Wildlife
Trusts’ logo.

As with all materials,
merchandise should
feature the logo on a
colour from the colour
palette. Black (as shown
here) or white may

also be used.

~ Y

dlife| .

A

5
QusTEl

Back to contents 21



Powerpoint presentations

The Wildiife Trust for Birmingham, The Wildilfe Trust for Birmingham,
and the Black Country and the Black Country

Natural Communities

Biodiversity and natural places contribute to everyone’s
quality of life, providing:

« Inspiration, excitement and comfort — a feeling of
well-being to assist physical and mental health.

« A vivid place in which to learn.

« Basic life support, maintaining our air, soils, water
and climate and limiting effects, such as flooding

and pollution.

* The essential resources for jobs and support to the
local economy.

Protecting Wildlife for the Future

Securing Living Seas

Protecting Wildlife for the Future

Protecting Wildlife for the Future

The Wildlife Trusts 2009

Powerpoint screens are
available in both the vertical
and horizontal format.

Templates are available to

download in each colour way
to suit your project.

Download Powerpoint templates

Back to contents 22



Consistent identity at work The Wildife Trusts 2009

Websites

The Wildlife Trusts’ collective
website is being reviewed at
present, and a template will be
prepared which may be used by
individual Trusts.

Get Dnvolved!

- 1

3 Ii_ ! ""’l,' "1; Samples here show how
Search ol 1 consistent colours, typefaces
Upcoming Ewventy and positioning help brand
these websites. Wherever possible
the website address should be
clearly visible on all publications,
in order to compliment online
marketing activities.

Photography

; — = ‘ — - Using photographs across all
materials in as large a format
as possible, as dramatically as
possible, as close up as possible,
is usually the most inspiring
approach.

Take the time to choose photos
that are in sharp focus, with
good composition, and try to
ensure the shot you are using
best represents the story you
are telling.

Back to contents 23



Using grids as templates

The following pages show recommended
text grids for newsletters, posters, notices,
leaflets, brochures and letterheads.

Our brand is important and Trusts can
really help to get the message across

by presenting a consistent image that
coordinates with our identity.

The templates are set up for use in Adobe
Indesign CS3 and Microsoft Word and
should make it easier for you to produce
good communications. Before you start a
new layout, write the copy and choose the
photographs required. The copy should
be written in plain English, with correct
spelling, grammar and punctuation. Keep
it simple, positive, concise and interesting.

In Microsoft Word, to select a template,
click on one of the links in the side column
and the template will open. Save and name
the template to a folder on your computer
using the menu along the top of the
window File > Save As.

In the template, the text is set by default to
Arial and aligned to the left, for the main copy.
Add variety to your text using bold and italics
and changes in type size, for headings, quotes
and captions. Text can be changed using the
text formatting window View > Toolbars >
Formatting

You may also wish to include digital
photographs taken by your trust members;
please ensure that the images are bright,

in focus and well composed. Do not use

poor photographs as these will make your
publications look unattractive. To add photos
to the templates simply go to the Insert >
Picture > From File... found at the top of
your screen.

Do remember that you are the voice of the
Wildlife Trusts. It is important to us that

we communicate a consistent message to

the public. Please refer to page 4, 5, and 6
regarding the use of the Wildlife Trusts logo,
fonts and colour.

The Wildlife Trusts 2009

Back to contents
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Stock grids: A4 portrait The Wildife Trusts 2009

Basic text grids for publications

210 210

The layout of text pages
within publications should
be determined by the
contents.

L& |
L& |

Basic page grids are
provided for use if required.

Download Microsoft Word template
(2-column)

Download InDesign CS3 template
(2-column)

Download Microsoft Word template
(3-column)

Download InDesign CS3 template
(3-column)

2-column 3-column

All measurements in mm Back to contents 25



[ &1

Stock grids: A4 landscape The Witdiite Trusts 2009

Basic text grids for publications

297

15 85 6 85 6 85 15

The layout of text pages
within publications should
be determined by the
contents.

Basic page grids are
provided for use if required.

Download Microsoft Word template

Download InDesign CS3 template

3-column

All measurements in mm Back to contents 26



Stock grids: Ab

Basic text grids for publications

148

2-column

All measurements in mm

The Wildlife Trusts 2009

The layout of text pages
within publications should
be determined by the
contents.

Basic page grids are
provided for use if required.

Download Microsoft Word template

Download InDesign CS3 template

Back to contents 27



Stock grids: DL

Basic text grids for publications

297
LJ 82 16.5 82 16 86
‘ 97 100 100
297
Outer

All measurements in mm

Inner

297
82 18 82 ‘16.5‘ 82 L5‘
] ! o |
100 100 97
297

The Wildlife Trusts 2009

The layout of text pages
within publications should
be determined by the
contents.

Basic page grids are
provided for use if required.

Download Microsoft Word template
(DL Outer)

Download Microsoft Word template
(DL Inner)

Download InDesign CS3 template

Back to contents 28



Please note...

All external documents should display
the charity registration number.

Other Wildlife Trust brands

There are a number of other
associated brands, eg Wildlife Watch.

It is not within the scope of this
document to deal with these sub-brands
or related brands in detail, as broader
considerations apply, such as the

legal and administrative relationship
between some of these brands and

“The Wildlife Trusts’.

At this stage, designers and marketers
should put themselves in the place of
the audience/reader. What would be the
clearest piece of communication, the
least confusing?

Wherever possible, the rules set for
working with partners and sponsors

apply: try to avoid using logos together;
where possible use phrases in place of logos
and if partner logos must appear alongside
each other, ideally display them on the back
of the material/publication.

Other issues

There are other issues around the use of
the logo — for example, agreeing an
approach to design issues linked to
bilingual materials — which we may wish
to work on in teams to enable us to take
forward our collective brand.

The Wildlife Trusts 2009

Back to contents
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